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PREFACE 
 

This book entitled “Computer Aided Civil Engineering Drawing Lab Manual” is intended for the 

use of fourth semester (i.e, II-II) B.Tech (civil) students of Marri laxman Reddy Institute of 

Technology and Management, Dundigal, Hyderabad. The main objective of the Computer Aided 

Civil Engineering Drawing Lab Manual is to teach the student basic drawing fundamentals in 

various civil engineering applications, especially in building drawing This book lays foundation 

of certain basic concepts and skills that can be repeatedly employed by the students in their 

future endeavours. The main aim of this book is to develop the habit of scientific reasoning and 

providing answers to all the doubts that arise during the course of conducting experiments. The 

book was written as per the new syllabus prescribed by the AUTONOMOUS in a simple 

language. Hence, we hope this book serve for better understanding by the student community 

with all details of experiments 

By, 

 

Mrs. B. Lavanya 

Assistant Professor, 

Department of Civil Engineering 
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GENERAL INSTRUCTIONS 
 

1. Remove your shoes or wear foot socks before you enter the lab. 

2. Observe silence when you are in the laboratory 

3. Students are instructed to come to laboratory on time. Late comers are not entertained in the 

lab. 

4. Students should be punctual to the lab. If not, conducted experiments will not be repeated. 

5. Students are expected to come prepared at home with the experiments which are going to be 

performed. 

6. Students are instructed to display their identity cards and apron before entering into the lab. 

7. Students are instructed not to bring mobile phones to the lab. 

8. Breakage amount will be collected from the student for causing damage to the instruments / 

Equipment’s due to wrong operation or carelessness 

7. For each lab class, all the students are expected to come with observation note book, record 

note book, calculator, pencil, eraser, sharpener, scale, divider, graph sheets. 

8. Students should update the records and lab observation books session wise before leaving the 

lab and should get his lab observation book signed by the faculty. 

9. Students should submit the lab records 2/3 days in advance to the concerned faculty 

members in the staff room for their correction and return. 

10. Students should not move around the lab during the lab session. 

11. If any emergency arises, the student should take the permission from faculty member 

concerned in written format. 

12. The faculty members may suspend any student from the lab session on disciplinary grounds. 
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SAFETY PRECAUTIONS 
 

 

 

1. Report any problems with the computer to the person in charge. 

 
2. Shut down the computer properly. 

 
3. Do not bring any food or drinks in the computer room. 

 
4. Do not touch any part of the computer with wet hands. 

 
5. Do not hit the keys on the computer too hard. 

 
6. Playing games is prohibited in the computer laboratory. 

 
7. Don’t damage, remove, or disconnect any labels, parts, cables or equipment. 

 
8. Do not install or download any software or modify or delete any system files 

on any labcomputers. 

 
9. CD – ROM’s and other multimedia equipment are for official work only. 

Do not usethem for recreational activities. 

 

10. If you leave the lab, do not leave your personal belongings unattended. 
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INSTITUTION VISION AND MISSION 
 

 

 

VISION 
 

To establish as an ideal academic institutions in the service of the nation, the world and the 

humanity by graduating talented engineers to be ethically strong, globally competent by 

conducting high quality research, developing breakthrough technologies, and disseminating and 

preserving technical knowledge. 

 

 

MISSION 
 

To fulfil the promised vision through the following strategic characteristics and aspirations: 

 

 Utilize rigorous educational experience to produce talented engineers 

 Create an atmosphere that facilitates the success of the students 

 Prudent and accountable resource management. 

 Programs that integrate global awareness, communication skills and leadership abilities. 

 Education and Research partnerships with institutions and industries for preparing the 

students for interdisciplinary research 

 Successful alumni in their profession at global level. 



 

 

DEPARTMENT VISION, MISSION , PROGRAMME EDUCATIONAL OBJECTIVES 

AND SPECIFIC OUTCOMES 

 

 

VISION 
 

The Civil Engineering department strives to impart quality education by extracting the 

innovative skills of students and to face the challenges in latest technological advancements and 

to serve the society. 

 

 
MISSION 

 

 Provide quality education and to motivate students towards professionalism 
 

 Address the advanced technologies in research and industrial issues 

 

 
PROGRAMME EDUCATIONAL OBJECTIVES 

 

The Programme Educational Objectives (PEOs) that are formulated for the civil engineering 

programme are listed below;‖ 

PEO-I solving civil engineering problems in different circumstances  

PEO-II Pursue higher education and research for professional development. 

PEO-III Inculcate qualities of leadership for technology innovation and entrepreneurship. 

 

 

PROGRAM SPECIFIC OUUTCOMES 
 

PSO 1 - UNDERSTANDING: Graduates will have ability to describe, analyse and solve problems 

using mathematical,  scient ific,  and engineering knowledge . 

  

PSO 2 - ANALYTICAL SKILLS: Graduates will have an ability to plan, execute, maintain, 

manage, and rehabilitate civil engineering systems and processes. 

   

PSO 3 - EXECUTIVE SKILLS: Graduates will have an ability to interact and work effectively in 

multi disciplinary teams. 
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PROGRAMME OUT COMES 
1. Engineering knowledge: Apply the knowledge of mathematics, science, engineering 

fundamentals, and an engineering specialization to the solution of complex engineering 

problems.  

2. Problem analysis: Identify, formulate, review research literature, and analyze complex 

engineering problems reaching substantiated conclusions using first principles of 

mathematics, natural sciences, and engineering sciences.  

3. Design/development of solutions: Design solutions for complex engineering problems and 

design system components or processes that meet the specified needs with appropriate 

consideration for the public health and safety, and the cultural, societal, and environmental 

considerations.  

4. Conduct investigations of complex problems: Use research-based knowledge and 

research methods including design of experiments, analysis and interpretation of data, and 

synthesis of the information to provide valid conclusions.  

5. Modern tool usage: Create, select, and apply appropriate techniques, resources, and 

modern engineering and IT tools including prediction and modeling to complex engineering 

activities with an understanding of the limitations.  

6. The engineer and society: Apply reasoning informed by the contextual knowledge to 

assess societal, health, safety, legal and cultural issues and the consequent responsibilities 

relevant to the professional engineering practice.  

7. Environment and sustainability: Understand the impact of the professional engineering 

solutions in societal and environmental contexts, and demonstrate the knowledge of, and 

need for sustainable development.  

8. Ethics: Apply ethical principles and commit to professional ethics and responsibilities and 

norms of the engineering practice.  

9. Individual and team work: Function effectively as an individual, and as a member or 

leader in diverse teams, and in multidisciplinary settings.  

10. Communication: Communicate effectively on complex engineering activities with the 

engineering community and with society at large, such as, being able to comprehend and 

write effective reports and design documentation, make effective presentations, and give 

and receive clear instructions.  

11. Project management and finance: Demonstrate knowledge and understanding of the 

engineering and management principles and apply these to one’s own work, as a member 

and leader in a team, to manage projects and in multidisciplinary environments.  

12. Life-long learning: Recognize the need for, and have the preparation and ability to engage 

in independent and life-long learning in the broadest context of technological change. 
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COURSE STRUCTURE, OBJECTIVES & OUTCOMES 
 

COURSE STRUCTURE 
 

Computer Aided Design laboratory will have a continuous evaluation during sixth semester for 

30 sessional marks and 70 end semester examination marks. 

Out of the 30 marks for internal evaluation, day-to-day work in the laboratory shall be evaluated 

for 20 marks and internal practical examination shall be evaluated for 10 marks conducted by the 

laboratory teacher concerned. 

The end semester examination shall be conducted with an external examiner and internal 

examiner. The external examiner shall be appointed by the Principal / Chief Controller of 

examinations. 

 

COURSE OBJECTIVES 
 

1. The objective of this lab is to teach the student usage of Auto cad, basic drawing 

fundamentals in various civil engineering applications, especially in building drawing. 

2. The objective of this course is to teach students the basic commands and tools necessary for 

professional 2D drawing, 3D drawing and drafting using AutoCAD 

3. Students able to learn to sketch and take field dimensions. 

4. Students able to learn to take data and transform it into graphic drawings. 
Students able to learn basic engineering drawing formats 

. 

COURSE OUTCOMES 

CE 227.1 Understand CAD  software and basic functions 

CE 227.2 Evaluate plans of Single storied  building & multistoried buildings 

CE 227.3 Develop different sections at different elevations 

CE 227.4 Detailing of building components like doors, windows roof trusses 

CE 227.5 
Develop section and elevation for single and multistoried buildings using CAD 

software. 

 

COURSE ARTICULATION MATRIX (CO - PO / PSO MAPPING):  

Program  

outcomes 
1 2 3 4 5 6 7 8 9 10 11 12 PSO 

1 

PSO 

2 

PSO 

3 CE214.1 3 3 2 3 3 3 
      

3 3 3 
CE214.2 3 3 2 3 3 3 

      
3 3 3 

CE214.3 3 3 2 3 3 3 
      

3 3 3 
CE214.4 3 3 2 3 3 3 

     
3 3 3 3 

CE214.5 3 3 2 3 3 3 
     

3 3 3 3 
CE214.6 3 3 2 3 3 3 

     
3 3 3 3 

Total 18 18 12 18 18 18 
     

9 18 18 18 

Average 3 3 2 3 3 3      3 3 3 3 



x 

 

 

LIST OF EXPERIMENTS 
 

 

1. Introduction to computer aided drafting & coordinate system. 

2. Exercise on Draw & Modify tool bars. 

3. Exercise on Layer, Dimension, Texting & Block etc. 

4. Drawing a plan of Building and dimensioning using layers. 

Single storied buildings b) Multi storied buildings. 

5. Developing sections and elevations for given 

a) Single storied buildings b) Multi storied buildings. 

6. Drawing of building components like walls, lintels, Doors, and Windows. 

7. Introduction to 3 – D view. 

8. Exercise on 3 – D. 
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EX.NO: 1 

 

Date: 

 

INTRODUCTION TO COMPUTER AIDED DRAFTING AND DIFFERENT 

COORDINATE SYSTEM 

 

AIM 

To learn the concept of computer aided drafting and introduce to different coordinate system in 

AutoCAD software package. 

INTRODUCTION 

Drawing is the language of engineers. An engineer must be well conversant with drawings. 

Drawings represent reduced shape of structure and the owner will be able to see what is going 

to happen. Drawings are prepared as per the requirements of owner. In case of public buildings, 

the functional aspects are studied and accordingly the drawings are prepared as per 

recommendations laid down in National Building Code (N.B.C) or as per Indian Standard 

specifications. Any modifications like additions or omissions can be suggested from a study of 

the drawings before actual construction of the structure is started. Drawings provide a language 

with specific data to Architects, Engineers and workmen at the site to construct the structure 

accordingly. 

In case of public buildings or any other civil engineering works, it is essential to work out 

different items of construction with their quantities for estimating the total cost of construction 

project. For this purpose, drawings of different parts and different views are essential so that 

the approval of work from the sanctioning authority can be obtained. Further the detailed 

drawings form an essential contract documents when the work is handed over to a contractor. 

Hence it is necessary to prepare detailed drawings, which will inform the contractor, the exact 

information, which he needs during the construction of different items of work. Drawings, thus 

prepared should be carefully even after the completion of work. Thus, it becomes asses the 

possibility of further vertical expansion by referring to the foundation details initially provided. 

REQUIREMENTS OF GOOD DRAWING: 

1. Drawing should be clear, simple and clean 

2. Should agree with the actual measurements by the accurately drawn scaled measurements. 

3. Exact information should be provided in order to carry out the work at site without scaling 

for missing measurements 

4. Only minimum notes to support the drawings should be indicated in the drawings. 

5. Sufficient space should be provided between the views so as to mark the dimensions 

without crowding. 
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INTRODUCTION TO COMPUTER AIDED DRAFTING 

Computer Aided Drafting is a process of preparing a drawing of an object on the screen of a 

computer. There are various types of drawings in different fields of engineering and sciences. 

In the fields of mechanical or aeronautical engineering, the drawings of machine components 

and the layouts of them are prepared. In the field of civil engineering, plans and layouts of the 

buildings are prepared. In the field of electrical engineering, the layouts of power distribution 

system are prepared. In all fields of engineering use of computer is made for drawing and 

drafting. 

The use of CAD process provides enhanced graphics capabilities which allows any designer to 

1. Conceptualize his ideas 

2. Modify the design very easily 

3. Perform animation 

4. Make design calculations 

5. Use colours, fonts and other aesthetic features. 

REASONS FOR IMPLEMENTING A CAD SYSTEM 

1. Improved productivity in drafting 

2. Shorter preparation time for drawing 

3. Reduced man power requirement 

4. Custom modifications in drawing are easier 

5. More efficient operation in drafting 

6. Minimized transcription errors in drawing 

7. Better designs can be evolved 

8. Revisions are possible 

9. Colors can be used to customize the product 

10. Hatching of all sections with different filling patterns 

LAUNCHING AUTOCAD FROM OPERATING SYSTEM 

 Click on Start. 

 Go to Programs 

 Go to Auto Desk 

 Go to Auto CAD 2012- English 

 Click on Auto CAD 2012- English. 

Using your pointing device 

One of the key means of controlling commands & inputting information into your drawing file 

will be by using your mouse. 
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Using three button mouse 

1. Left button: data / accept – used to select command & enter points. 

2. Middle button: It is used as Pan and scroll zooming 

3. Right button: Reset / reject / repeat last command – used to end a command or to display 

a small pull-down menu or to repeat last command. 

Using the Key boards 

1. Typing Command name is “command line”. Can run all the commands in auto CAD. 

2. Enter button and Space bar can be used to accept a command or repeat last command. 

3. The Function Keys can be used as toggle buttons to switch ON/ OFF for some of functions. 

The Important ones are 

 
 

S.NO FUNCTION KEY FUNCTION 

1 F1 Help 

2 F2 Command line history 

3 F3 Object snap 

4 F4 3D Osnap 

5 F5 Isoplane Top/Left/Right 

6 F6 Dynamic UCS on/off 

7 F7 Toggle grid on/off 

8 F8 Ortho on/off 

9 F9 Snap on/off 

10 F10 Polar on/off 

11 F11 Object snap tracking 

12 F12 Dynamic on/off 

 
 

USER COORDINATE SYSTEM 

You can enter pts directly on the command line using 3 different systems. The one you use is 

depend on which is more applicable for the situation. The first assignment will get you used to 

this the 3 systems are as follows. 

a. Absolute Coordinate system (x, y) 

Absolute coordinates refers to a Cartesian System that uses x-axis, y-axis, and sometimes a z- 

axis to establish a point some distance from a common origin. 

b. Relative rectangular Coordinate system @ (x, y) 

c. Relative Polar Coordinate system: You would use this system if you know that you want 

https://www.computerhope.com/jargon/x/xaxis.htm
https://www.computerhope.com/jargon/x/xaxis.htm
https://www.computerhope.com/jargon/z/zaxis.htm
https://www.computerhope.com/jargon/z/zaxis.htm
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to draw a line a certain distance at a perpendicular angle. We would enter this as at D < A. 

where, D is the distance and A is the angle. 

COMMANDS IN AUTOCAD BEFORE STARTING THE DRAWING 

Before we start to draw any drawing, we must set Units, Limits & Grid. 

Units 

Command: units (enter) Type Decimal Millimetres Click on ok. 

Limits 

Command: limits (enter) Specify lower left corner – (0, 0) Specify upper right corner (10000, 

10000) 

Grid on 

Click on F7 

Zoom Command 

Command: Z enter Options: (All / centre/ dynamic/ Extents/ Previous/ scale/ window/ object/ 

real Time) 

Line command 

Command: L (enter) 

USING ABSOLUTE COORDINATE SYSTEM 

Absolute Coordinates uses the Cartesian System to specify a position in the X, Y, and (if 

needed) Z axes to locate a point from the 0-X, 0-Y, and 0-Z (0,0,0) point. To locate a point 

using the Absolute Coordinate system, type the X-value, Y-value, and, if needed, the Z-value 

separated by commas (with no spaces). 

 

1. Enter LINE command: L [Enter] 

2. Start line at point A: 0,0 [Enter] 

3. End first line at point B: 2,2 [Enter] 

4. End of second line at point C: 2,3 [Enter] 



COMPUTER AIDED CIVIL ENGINEERING DRAWING LAB 

5 

 

 

Example on Absolute Coordinate System 
 

Steps to be followed to draw the diagram 
 

1. L enter 2. 0, 0 

3. 20, 0 4. 20, 20 

5. 50, 20 6. 50, 30 

7. 40, 30 8. 40, 40 

9. 50, 40 10. 50, 50 

11. 0, 50 12. 0, 30 

13. -20, 30 14. -20, -30 

15. 0, -30 16. 0, 0 

USING RELATIVE RECTANGULAR COORDINATE SYSTEM 

After first points entered, your next points can be entered by specifying the next coordinate 

compare/relative from the first points. The relative coordinate started with symbol “@” tell 

AutoCAD it was a relative coordinate. Using relative coordinate, points entered by typing @x,y 

[Enter]. 
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3. End first line at point B: @2,2 [Enter] 

4. End of second line at point C: @0,1 [Enter] 

Example on Relative Rectangular Coordinate System 
 

Steps to be followed to draw the diagram 
 

1. L enter for line & specify and point 2. @ 40, 0 

3. @ 0, 40 4. @ 60, 0 

5. @0, 80 6. @ 100, 0 

7. @ 50, 50 8. @ 0, 30 

9. @ 0, -30 10. @ -50, -50 

11. @ -30, 0 12. @ 0, -50 

13. @ -50, 50 14. @ 0, -50 

15. @ 30, -30 16. @ 0, -30 

17. @ 0, -70 or c  

USING RELATIVE POLAR COORDINATE SYSTEM 

Polar coordinates used when you need to draw the next points at specify angle. Polar 

coordinates system in AutoCAD specifies distance length at which angle. Using polar 

coordinate, points entered by typing @distance<angle [Enter]. 
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3. End first line at point B: @2.828<45 [Enter] 

4. End of second line at point C: @1<90 [Enter] 

Example on Relative Polar Coordinate System 
 

Steps to be followed to draw the diagram 
 

1. Type L and press enter 2. @100 < 0 

3. @ 70 < 45 4. @ 30 < 90 

5. @ 70 < 135 6. @ 50 < 180 

7. @ 50 < 270 8. @ 40 < 315 

9. @ 80 < 180 10. @ 50 < 270 

Construction Line 

Command: XL enter XLINE Specify a point or [ Hor/ ver/ Ang/ Bisect/ offset]: h 

Polyline 

Command: PL (enter) 

Specify Start point: 

Specify next point (or) [ Arc/ Half width/ length/ undo/ width]: click on screen 

For arc in the polyline enter option ‘A’ 

Arc 

Command: Arc (enter) 

Specify 1st point: click on screen 

Specify 2nd point: click on screen 

Specify end point: click on screen 

Revision cloud 

Command: Revcloud (enter) 

Specify start pt or [arc/length/object/ style] 

s (enter) 
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Spline 

Command: Spl (enter) 

Click on screen 

Hatch 

Command: h (enter) 

Scale – 50 (properties) 

Click on pick pts. 

Click on rectangle 

Command: H (enter) 

Scale – 0.5 

Pick pts 

Click on rectangle 

Point & Point style 

Points are very simple objects and the process of creating them is very simple. 

Points are rarely used as drawing components although there is no reason why they could not 

be. 

For Example: Points are automatically created when you measure and divide commands and to 

set act distance along lines 

Point: 

Command: po (enter) 

Click on Screen 

Object snap 

Command: OS (enter) 

Select the required node otherwise (select all) 

Text command 

Command: t (enter) 

Specify two corners 

Enter the text 

Click on ok 

Copy 

Command: co (or) cp (enter) 

Select the Object (enter) 

Select the base point and place the point 

Mirror 

Command: mi (enter) 
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Specify the first pt of mirror line 

Specify the second pt of mirror line 

Erase the source object (Yes/No) <N> 

Offset 

Command: O (enter) 

Enter the offset distance: 

example: 10 (enter) 

Select the object and direct the offset 

Rectangular Array 

Command: ar (enter) 

Select Tick The rectangular array 

Enter the no of rows 

Enter the no of columns 

Click on the selected objects button 

Polar array 

Command: ar (enter) 

Tick polar array 

Select the objects 

Enter the total no of items 

Specify the angle 

Specify the centre point 

Move 

Command: m (enter) 

Select the object 

Specify the base point 

Click wherever required 

Rotate 

Command: ro (enter) 

Select the object (enter) 

Specify the base point 

Enter the angle 

Example: 450 enter 

Scale 

Command: sc (enter) 
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Specify the base points 

Enter the scale factor Example: 2 (enter) 

Stretch 

s (enter) 

Select the object (enter) 

Specify Base point and drag the mouse 

towards the required direction V 25 

Trim 

Command: tr (enter) 

Select cutting edges (enter) 

Select the objects to trim 

Extend 

Command: Ex (enter) 

Select boundary edges (enter) 

Then select the object to extend 

Break 

Command: br (enter) 

Select 1st point and 2nd point 

Chamfer 

Draw a rectangle of 100 x 50) Command: Cha (enter) d (enter) 

Enter the distance 15 (enter) 

Enter the distance 10 (enter) 

Select two adjacent line on screen 

Fillet 

Command: f (enter) 

r (enter) 

example: 10 (enter) 

Explode 

x (enter) 

Select the object (enter) 

CONVENTIONAL SIGNS AND SYMBOLS FOR HATCH 

Conventional signs are used to represent the particular item like stone masonry, brick masonry, 

concrete etc in the section of drawing. (i.e.,) when the materials are cut by any imaginary plane. 

Conventional symbols are provided to indicate doors, windows, their fixing, movement of 
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shutters. When they are cloud or opened, various water supply and sanitary fixtures like tap, 

wash basin, W.C., urinals, Kitchen sink, shower etc, symbols are used to indicate the position 

of electrical fittings like lamp, switch, power socket, fan etc. To indicate positions of furniture 

on drawing room, bedroom, suitable symbols are used. 

The Bureau of Indian standards (B.I.S) has recommended the conventional signs and symbols 

for the following purposes. 

1. Avoid confusion and to understand the drawings 

2. Save the time in making out various details in the drawing 

3. Identify the various details of materials, Electrical fixtures, water supply and sanitary 

fittings, Position of furniture’s etc. 

4. To prevent any dispute between contractor and owner in the actual construction of the 

structure. The conventional signs for civil engg materials is shown in fig 
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PRACTICAL IMPLEMENTATION 
 

 

 
1. Describing position 

 

 

 

 

 
2. Location of Air transport 

 

 

 

 
 

3. Map Projections 

 

 

 

 

4. Latitude and Longitude 
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VIVA QUESTIONS 

 

1. What is the full form of AUTOCAD? 
 

 
 

2. List the benefits of AUTOCAD? 
 

 
 

3. What are the limitations of AUTOCAD? 
 

 

 

 
 

4. What are the applications of CAD? 
 

 

 

 
 

5. Who created the AUTOCAD? 
 

 
 

6. Who is the father of AUTOCAD? 
 

 
 

7. Who is the owner of AUTOCAD? 
 

 
 

8. Who was discovered AUTOCAD? 
 

 
 

9. What is the difference between AUTOCAD and AUTODESK? 
 

 

 

 
 

10. Define polar coordinates. 
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EX.NO: 2 
 

Date: 

 
AIM 

 
EXERCISE ON DRAW & MODIFY TOOL BARS 

To learn the commands in Draw tool bars. 

PROCEDURE 

DRAW COMMANDS 

1. Line 10. Solid 

2. Pline 11. Drawing of polygon 

3. Line type 12. Point 

4. Curves 13. Erasing of object 

5. Circle 14. Colouring of Object 

6. Donut 15. Filling of object 

7. Ellipse 16. Hatch 

8. Arc 17. Scaling of drawing 

9. Rectangles  

1. LINE: A line is specified by giving its two end points or first point and the distance of line 

along with its angle of inclination. A line can be drawn by using two commands. 

Command: line 

Specify first point: Specify a point (1) 

Specify next point or [Undo]: Specify a point (2) 

The second point can be indicated by @d<a 

Where d is the distance of line and a is the angle of inclination in degrees 

 
 

2. PLINE: This is a poly line which allows continuous segment of the line and it is drawn 

similar to the line command. The polyline allows changing the thickness of the line 

according to the requirement. 

From the Draw tool bar choose the Polyline flyout. 

Draw pull down menu: Polyline 

At the command prompt, enter pline 

Syntax 

Specify start point: Specify a point (1) 

Current line-width is <current> 

Specify next point or [Arc/Close/Half width/Length/Undo/Width]: Specify a point (2) or enter 

an option. 
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3. LINE TYPE: Creates, loads, and sets line types. The LINETYPE command defines line 

characteristics consisting of dashes, dots, and spaces. 

Format menu: Line type or Command line: line type 
 

4. CURVES: Following are the various types of 

i. Circle 

ii. Ellipse 

iii. Arc 

iv. Regular or any other type. 

5. CIRCLE: This command draws the circle by using four methods: 

 Centre point and radius 

 Two-point circle 

 Three-point circle 

 Tangent circle 

At the command prompt, enter circle 

Specify centre point for circle or [3P (Three Points)/2P (Two Points)/Ttr]: Specify a point 

or enter an option 
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6. DONUT: This draws filled circles and rings. 

Donuts are constructed of a closed polyline composed of wide arc segments. At the command 

prompt, enter donut 

a. Specify inside diameter of donut <current> 

b. Specify a distance or press ENTER 

c. If you specify an inside diameter of 0, the donut is a filled circle. 

d. Specify outside diameter of donut <current>: Specify a distance or press ENTER 

e. Specify centre of donut or <exit>: Specify a point (1) or  press ENTER to end the 

command 

 
7. ELLIPSE: It is a curve having major and minor axis with a centre. Creates an ellipse or an 

elliptic arc. 

Axis end point: Defines the first axis by two specified endpoints. The angle of the first axis 

determines the angle of the ellipse. The first axis can define either the major or the minor axis 

of the ellipse. 

 
8. ARC: Creates an elliptical arc. The angle of the first axis determines the angle of the 

elliptical arc. The first axis can define either the major or the minor axis of the elliptical arc. 

Center: Creates the ellipse by a specified centre point. 

Isocircle: Creates an isometric circle in the current isometric drawing plane. 

At the command prompt, enter ellipse 

Arc: The arc is a curve specified by centre and radius as well as the start angle and end angle. 

There are seven methods used for drawing an arc. 

1. Three-point method 

2. Start point-centre point –end point 

3. Start point-centre point-length of chord 

4. Start point-end point –angle of inclusion 

5. Start point-end point-direction 

6. Start point-centre point-angle of inclusion 

7. Start point-end point-radius 

These methods can be used by executing the arc command 

ARC: creates an arc. 

At the command prompt, enter arc 

Centre/<start point>: specify a point, enter c, or press enter 

Polyarc: the second method of the drawing the arc is poly arc by use of pline command. This 
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command allows drawing of filled arc of any width .it also allows for drawing of a regular or 

irregular curve. 

 
9. RECTANGLES: Draws a rectangular polyline 

At the command prompt, enter rectangle 

a. First corner: specify point (1) 

b. Other corner: specify point (2) 

Drawing of Rectangle: A rectangle can be drawn by LINE command or by Rectangle 

command. The PLINE command also allows for drawing of hollow or filled rectangle. A 

SOLID command is also used for drawing of filled rectangles. 

 
10. SOLID: Creates solid –filled polygons solids are filled only when fill system variable is set 

to on view is set to plan. 

a. At the command prompt, enter solid 

b. First corner: specify point (1) 

c. Other corner: specify point (2) 

d. The first two points define one edge of the polygon. 

e. Third point: specify a point (3) diagonally opposite the second 

f. Fourth point: specify a point (4) or press enter 

 
 

11. DRAWING OF POLYGON:  Creates an equilateral closed polyline, A polygon is a 

polyline object. AUTOCAD draws polyline with zero width and no tangent information. 

a. At the command prompt enter polygon 

b. Number of sides <current>: enter a value between 3 and 1024 or press enter Edge/<centre 

of polygon>: specify a point (1) or enter. 

 
12. POINT: Creates a point object points can act as nodes to which you can snap objects you 

can specify a full 3D location for a point. 

At the command prompt, enter point 

Point: specify a point 

 
 

13. ERASING OF OBJECT: The object can be removed or erased by use of erase command 

ERASE 

This removes object from drawing 

At the command prompt, enter erase Select objects: use an object selection method. 
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14. COLOURING OF OBJECT: The object can be drawn with any variety of colour which 

ranges from 0 to 256. The setting of colour can be done by colour command 

COLOUR 

Sets the colour for new objects. At the command prompt, enter colour <current>: enter a value 

(1-255), colour name, by block, or by layer 

 
15. FILLING OF OBJECT: The object can be filled with different colours and patterns by 

use of hatch command 

This command allows selection of various patterns, scale of pattern and angle of pattern. 

 
 

16. HATCH: This fills an area with a pattern. HATCH fills the specified hatch boundary with 

non-associative hatch A non –associative hatch is not updated when its boundaries are modified 

a hatch boundary consists of an object or objects that completely enclose an area 

At the command prompt, enter hatch 

Pattern (? Or name/ U, style) <current>: enter a predefined pattern name, enter u, enter? Or 

press enter. 

 
17. SCALING OF DRAWING: zoom command displays the object at a specified scale factor. 

the value entered is relative to the limits of the drawing for example entering 2 doubles the 

apparent display size of any objects from what it would be if it were zoomed to the limits of the 

drawing. 

If you enter a value followed by XP, auto CAD specifies the scale relative to paper scale unit’s. 

for example, entering 0.5xp displays model space at half the scale of paper space unit’s. the 

following illustration shows a number of viewports arranged in paper space. the view in each 

view port is scaled relative to paper space. the first view is scaled 1=1 

relative to paper space (1xp), the second is scaled 0.5=1 relative to paper space (0.5xp), and so 

on. 

AIM 

To learn the commands in Modify tool bar 

PROCEDURE 

TRANSFORMATIONS: These are the modifications in the drawn objects. There are different 

types of transformations used 

1. MOVE: This allows to move  or displace  objects a specified distance in a  specified 

direction 

a. At the command prompt, enter move 

b. Select objects: use an object selection method 
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c. Base point or displacement: specify a base point (1) 

d. Second point of displacement: specify a point (2) or press enter 

 
 

2. COPY: This is used for producing a duplicate copy of the drawing. At the command 

prompt, enter copy 

a. Select objects: use an object selection method 

b. <Base point or displacement >/multiple: specify a base 

 
 

3. ROTATE: It moves objects about a base point at the command prompt, enter rotate Select 

a. objects: use an object selection method 

b. <Rotate angle >/reference: specify an angle or enter r 

 
 

4. STRETCH: This moves or stretches objects. AutoCAD stretches lines, arcs, elliptical 

arcs, splines, rays and polyline segments that cross the selection window. 

a. At the command prompt, enter stretch 

b. Select objects: use the CPOLYGON or cross object selection method 

c. (1,2) Base point or displacement: specify a point (3) or press 

d. Second point of displacement: specify a point ($) or press 

 
 

5. EXTEND: This extends an object to meet another object. Objects that can be extended 

include arcs, elliptical arcs, lines, open 2D, and 3Dpolylines and rays. 

a. At command prompt, enter extend 

b. Select boundary edges 

c. (projmode=UCS, edge mode=no extend) 

d. Select objects: use an object selection method 

 
 

6. SCALE: This enlarges or reduces selected objects equally in X and Y Directions At the 

command prompt, enter scale 

a. Select objects: use an object selection method 

b. Base point: specify a point (1) 

c. <Scale factor>/reference: specify a scale or enter r 

 
 

7. TRACE: This creates solid lines. From the miscellaneous tool bar choose At the command 

prompt, enter trace 

a. Trace width<current>: specify a distance, enter a value, or press enter 
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b. From point: specify point (1) 

c. To point: specify a point (2) 

d. To point: specify a point (3) or press to end the command 

 
 

8. EXTRUDE: This creates unique solid primitives by extruding existing two-dimensional 

objects extrudes also creates solids by extruding two-dimensional objects along a specified 

path. we can extrude multiple objects with extrude 

a. At the command prompt enter, extrude 

b. Select objects: use an object selection method 

c. Path/<height of extrusion>: specify a distance or enter p 

 
 

9. MIRROR: This is used to producing mirror image of the object 

a. At the command prompt enter, mirror 

b. Select objects: use an object selection method 

c. First point of the mirror line: specify a point (1) 

d. Second point: specify a point (2) 

 
 

10. OFFSET: This creates concentric circles, parallel lines and parallel curves, offset creates a 

creates a new object at a specified distance from an existing object or through a specified 

point 

a. At the command prompt enter, offset 

b. Offset distance: specify a distance, enter t or press enter 

 
 

11. ARRAY: This creates multiple copies of objects in pattern. Each object in an array can be 

manipulated independently 

a. At the command prompt enter, array 

b. Rectangular or polar array<current>: enter an option or press enter specify a point 

 
 

12. CUTTING OF OBJECTS: The drawn objects can be cut or trimmed by using following 

commands 

i) TRIM: Trims objects at a cutting object defined by other objects. Objects that can be 

trimmed include arcs, circles, elliptical arcs, lines, open 2D and 3D polylines rays and 

splines 

a. At the command prompt, enter trim 

b. Select cutting edges: 
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c. Select objects: use object selection method 

d. <Select object to trim>/project/edge/undo: select an object, enter an option, or press enter 

ii) BREAK: This erases an object or splits the object in to two parts from the modify toolbar 

select break flyout 

a. At the command prompt, enter break 

b. Select objects: use an object selection method 

c. First point of the mirror line: specify a point (1) on an object 

d. Enter second point: specify the second break point (2) or enter F 

 
 

PRACTICAL IMPLEMENTATION 

1. Architectural drawing of all kinds 

2. Interior design and facility planning 

3. Easy to modify with the modify tool bar for accurate drawings. 
4. Easy to draw the basic geometrical shapes with the draw tool bar. 
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VIVA QUESTIONS 

 

1. What is the command for line? 
 

 
 

2. What are the options available in the draw tool bar? 
 

 
 

3. What are the options available in the modify tool bar? 
 

 
 

4. List out any five 2D commands. 
 

 
 

5. Explain the types of lines 
 

 
 

6. What is the use of hatching? 
 

 
 

7. What are the commands for cutting of objects? 
 

 
 

8. What is the use of F8 function key? 
 

 
 

9. What is the command for arc? 
 

 
 

10. How the command linear dimension is operated? 
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EX.NO: 3 

 

Date: 

 

EXERCISE ON LAYER, DIMENSION, TEXTING & BLOCK ETC 
 

AIM 

To learn the commands in layer, dimension and texting tool bar 

 
PROCEDURE 

Dimensioning in Drawings: The dimensions are inserted in the drawing by use of DIM 

command. There are various types of dimensions used in AutoCAD. 

1. Linear dimensions 

a. Horizontal- this allows horizontal dimensions 

b. Vertical- this allows vertical dimensions 

c. Aligned- this allows inclined dimensions 

d. Rotated- this allows inclined dimensions 

2. Angular dimensions 

a. This allows angular dimensioning of objects 

3. Radial dimensions 

a. This allows radial dimensioning of arc or circle 

4. Diametric dimensions 

a. This allows diametrical dimensions of the circle 

For dimensioning of objects, the first point and second point have to be specified. The 

dimension text must be written and then the position of dimension must be specified at the 

command prompt, enter dim 

Dim: Enter a dimensioning mode command 

AREA: This allows calculation of the area and perimeter of objects or of defined areas from 

the object properties toolbar, choose the inquiry flyout, then 

a. At the command prompt, enter area 

b. <First point>/object/add/subtract: specify a point or enter option 

 
 

FILLET: Rounds and fillets the edges of the object 

a. At the command prompt enter fillet Polyline / Radius / Trim / <Select first object>: 

b. Use an object selection method or enter an option Select first object 

c. Select second object: use an object selection method Enter radius <current>: specify a 

distance or press 

d. Chain / Radius <Select edge>: Select edges or enter c or r their intersection. 
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CO-ORDINATE SYSTEM: The co- ordinate system can be modified in the AutoCAD. There 

are two types of co- ordinate systems used. The WCS (World co- ordinate system) is a 

universal system in which its origin is at the fixed position. The UCS (User co- ordinate 

system) is a system in which user can fix his origin at any point. 

UCS: This manages user co- ordinate systems at the command prompt enter UCS 

 
 

UNION: This measures the distance and angle between two points. 

a. At the command prompt, 

b. Enter union 

c. Select object: Use an object selection method 

 

DISTANCE: This measures the distance and the angle between two points. 

a. At the command prompt area enter dist. 

b. First point: Specify a point (1) 

c. Second point: Specify a point 

d. (2) Distance = calculated distance 

e. Angle in XY plane = angle from XY plane = angle 

f. Delta X = change in X 

g. Delta Y = change in 

h. Y Delta Z = change in Z. 

 

REGENERATION OF DRAWING: ACAD provides a facility of regenerating a drawing to 

clear the cross points or marks on the screen. 

 REDRAW 

 REGEN 

 REGENALL 

 REGENAUTO 

 
TOLERANCE: This creates geometric tolerances. Geometric tolerances define the maximum 

allowable variations of form or profile, orientation, location and runout from the exact 

geometry in a drawing. They specify the required accuracy for proper function and fit the 

objects drawn in AutoCAD 

 
SKETCH: This creates a series of free hand line segments. From the miscellaneous toolbar, 

choose 

a. At the command prompt enter sketch 

b. Follow the prompting 
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TEXT: The text in software is indicated by font’s. the fonts define the shapes of the text 

characters that make up each character set. In AUTOCAD, you can use true type fonts in 

addition to AUTOCAD’s own compiled shape (SHX) fonts. 

A font is indicated by various parameters like 

i. Style: these are four types: normal, bold, italic, underline 

ii. Size: this is the size of characters 

iii. Colour: there are facilities to colour the characters selecting layer. 

iv. Type: different types of fonts may be used: 

 Mono text: COMPUTER AIDED DESIGN 

 Romans: COMPUTER AIDED DESIGN 

 Romand: COMPUTER AIDED DESIGN 

 
DTEXT: This displays text on the screen as it is entered. AutoCAD can create text with a 

variety of character patterns, or fonts. These fonts can be stretched, compressed, oblique, 

mirrored, or aligned in a vertical column by applying a style to the font .text can be rotated, 

justified, and made any size. 

a. At the command prompt, enter text 

b. Justify/style/<start point>: specify a point or enter an option 

 
 

TEXT: This creates a single line of text AutoCAD can create text with a variety of character 

patterns, or fonts. These fonts can be stretched, compressed, oblique, mirrored, or aligned in a 

vertical column by applying a style to the font. 

a. At the command prompt, enter text 

b. Justify/style/<start point>: specify a point or enter an option 

 
 

QTEXT: This controls the display and plotting of text and attribute of objects. 

a. At the command prompt, enter text 

b. ON/OFF <current>: enter on or off, or press enter 

 
 

LAYER: In this practice exercise, you create layers in the Properties Manager dialog box and 

select the layer from the Layer Control list to draw objects on the appropriate layer. 

To create the layers: 

a. On the ribbon, click Home tab > Layers panel > Layer Properties. 

b. In the dialog box, click New. Create the following layers: 

 Layer Name: Circle, Color: Red 

 Layer Name: Line, Color: Blue 
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 Layer Name: Rectangle, Color: Green 

 
Note: If you enter the layer name and then a comma, a new layer name field appears. The 

layers are automatically listed in alphabetical order. 

 

1. Close the Layer Properties Manager dialog box. 
2. Note: If you enter the layer name and then a comma, a new layer name field appears. 

The layers are automatically listed in alphabetical order. 

 

MATCH PROPERTIES 

1. Choose Modify, Match Properties. or 

2. Click the Match Properties Icon from the Standard toolbar. or 

3. Type Command: MATCHPROP or MA 

4. Select the object whose properties you want to copy (1). 

5. Select the objects to which you want to apply the properties (2). 

 
 

LAYER STATES 

1. Choose the layer icon. 

2. Select various layers to be ON, OFF, FROZEN, LOCKED, etc. 

3. Choose the Save State button. 

4. Choose Restore State to restore the layer settings. 
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COLOR COMMAND 

1. Choose Format, Color. or 

2. Type DDCOLOR at the command prompt. Command: DDCOLOR or COL or 

3. Choose Color on the Object Properties toolbar and then select a color from the list or select 

Other to display the Select Color dialog box. 

 
 

TIP: 

These settings ignore the current layer settings for color. 

By Layer 

If you enter by layer, new objects assume the color of the layer upon which they are drawn. 
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By Block 

If you enter by block, AutoCAD draws new objects in the default color (white or black, 

depending on your configuration) until they are grouped into a block. When the block is 

inserted in the drawing, the objects in the block inherit the current setting of the COLOR 

command. 

 
LINEWEIGHTS 

Loading and Changing Line weights 

1. Choose Format, Line weight... or 

2. Type LINEWEIGHT at the command prompt. Command: LINEWEIGHT or LWEIGHT or 

3. Pick a line weight to make current from the Object Properties menu. 
 

 
PRACTICAL IMPLEMENTATION 

11. Layer toolbar helps us to maintain drawing organized. 

12. Maintain drawing standard as well. 

13. Dimensioning tools can automatically measure distances and place dimensions on your 

drawing. 

14. The layer command is used to control and manage the drawings in AutoCAD for different 

purposes. 

15. It increases the display performance of the AutoCAD by hiding the portion of our drawing 

when needed. 

16. It also improves the visual complexity of the drawing. 

17. With the help of dimensions tool bar we can change the position style and height of 

character 

18. The layer command is used to control and manage the drawings in AutoCAD 
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VIVA QUESTIONS 

1. List out the types of lines. 
 

 
 

2. List the types of coordinate systems? 
 

 
 

3. Give 5 drawing file (DWG file) history. 
 

 

 

 
 

4. What is automated drafting? 
 

 

 

 
 

5. What is dynamic UCS? 
 

 

 

 
 

6. List out the function keys and their functions. 
 

 
 

7. List out the steps to save the drawing file. 
 

 

 

 
 

8. How to use the line and polyline options? 
 

 

 

 
 

19. Define aligned dimension? 
 

 

 
 

20. What is .dwg? 
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EX.NO: 4 

 

Date: 

 

DRAWING A PLAN OF BUILDING AND DIMENSIONING USING 

LAYERS 

A) SINGLE STORIED BUILDINGS B) MULTI STORIED BUILDINGS 

AIM 

Draw plan of Single-storey and Multi-storey building. 

SPECIFICATIONS 

1. Foundation: All the walls are taken to depth of 900mm below ground level and C.C bed 

700mm wide and 300mm thick. Footing with brick masonry 400mm wide and 600mm 

depth. 

2. Basement: The height of basement is 450mm and width of wall is 300mm. Steps are 

provided both on front side and rear side over a C.C bed of 150mm thick with an offset of 

150mm on all three sides. Tread and rise of steps are 300mm and 150mm. 

3. Flooring: Flooring consists of 20mm thick C.M. 1:4 over a bed of cement concrete (1:4:8) 

100mm thick. The remaining part of the basement is filled and compacted with sand. 

4. Superstructure & Roofing: All the walls are taken to a height of 3200mm and 200mm 

thick. 

5. Roofing consists of R.C.C. slab roofing 120mm thick and projected by 200mm beyond the 

outer face of walls. The roof slab is provided with weatherproof course 15mm thick. 

6. Sunshades: Continuous sunshade is provided on front side of the building. The thickness of 

sunshade at the wall end is 75mm and at the free end thickness is 50mm. Isolated 

sunshades are provided over windows and external doors extending the R.C.C Lintels kept 

over such openings on other three sides. The projection of sunshades is extended 600mm 

from the face of wall. 

7. Lintels: R.C.C lintels on all openings like doors, windows, and cupboards are 150mm thick 

having a bearing of 150mm on either side. 

8. Doors, Windows & Cupboards: 

D1 - 2No. 1000 x 2000mm Fully Paneled Door 

D2 - 1No. 900 x 1800mm Fully Paneled Door 

W - 6No. 1000 x 1200mm Fully Paneled Window 

CB - 1No. 1200 x 1500mm Cupboard 

INFERENCE 

The plan, section and elevation is drawn. 
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Single Storey Building 
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Multi storey building 
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VIVA QUESTIONS 

1. What are the commands for line, polyline and construction line? 
 

 
 

2. Give the steps how the option mirror is used? 
 

 

3. What is the purpose of Extrude option? 
 

 

 
 

4. What is the command for move and copy? 
 

 
 

5. What is the use of object snap tracking? 
 

 

 

 
 

6. What is the purpose of giving limits to the drawing file? 
 

 

 

 
 

7. What are the transformation commands? 
 

 

 

 
 

8. What are the types of dimensions in drawing? 
 

 

 

 
 

9. What is the command for rotate? 
 

 
 

10. What is known by drawing environment? 
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EX.NO: 5 
 

Date: 

 

 

 
 

AIM 

 
 

DRAWING A SECTIONS AND ELEVATIONS FOR GIVEN 

A) SINGLE STORIED BUILDINGS B) MULTI STORIED BUILDINGS 

Draw section ans elevation of Single-storey and Multi-storey buildings. 

 
 

SPECIFICATIONS 

1. Foundation: All the walls are taken to depth of 2000mm below ground level and C.C bed 

1000mm wide and 300mm thick with a PCC of 100 thick. 

2. Basement: The height of basement is 450mm and width of wall is 300mm. Steps are 

provided both on front side and rear side over a C.C bed of 150mm thick with an offset of 

150mm on all three sides. Tread and rise of steps are 300mm and 150mm. 

3. Flooring: Flooring consists of 20mm thick C.M. 1:4 over a bed of cement concrete (1:4:8) 

100mm thick. The remaining part of the basement is filled and compacted with sand. 

4. Superstructure & Roofing: All the walls are taken to a height of 3200mm and 200mm thick. 

Roofing consists of R.C.C. slab roofing 120mm thick and projected by 200mm beyond the 

outer face of walls. The roof slab is provided with weatherproof course 15mm thick. 

5. Sunshades: Continuous sunshade is provided on front side of the building. The thickness of 

sunshade at the wall end is 75mm and at the free end thickness is 50mm. Isolated sunshades are 

provided over windows and external doors extending the R.C.C Lintels kept over such 

openings on other three sides. The projection of sunshades is extended 600mm from the face of 

wall. 

6. Lintels: R.C.C lintels on all openings like doors, windows, and cupboards are 150mm thick 

having a bearing of 150mm on either side. 

7. Doors, Windows & Cupboards: 

D1 - 2No. 1000 x 2000mm Fully Paneled Door 

D2 - 1No. 900 x 1800mm Fully Paneled Door 

W - 6No. 1000 x 1200mm Fully Paneled Window 

CB - 1No. 1200 x 1500mm Cupboard 

INFERENCE 

The plan, section and elevation is drawn. 
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Single storey building 
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Multi Storey Building 
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PRACTICAL IMPLEMENTATION 

 

1. This knowledge will be helpful to draw building planning for single storey and multy 

stories building accurately and effectively with all the required details. 
 

 

VIVA QUESTIONS 

 

1. Define plan? 

 

 

 

 

 

2. What is meant by multi storied building? 
 

 
 

3. How to use hatch? 
 

 

 
 

4. What are the standard dimensions of main door and bathroom door? 
 

 
 

5. What are the standard dimensions of single and double window? 
 

 
 

6. What is meant by soft storey? 
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7.   door swings both ways. 
 

 
 

8. What is dimension of inner wall? 
 

 
 

9. what are the standard dimensions of ventilator? 
 

 
 

10. What is the thickness of outer wall? 
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EX.NO: 6 

 

Date: 

 

DRAWING OF BUILDING COMPONENTS LIKE WALLS, LINTELS, 

DOORS, AND WINDOWS 
AIM 

To draw the doors, windows and lintel as per the given dimensions. 

 
 

SPECIFICATIONS 

1. Foundation: The foundation for all walls will be in CC 1:4:8 Mix 800mm wide and 300mm 

thick laid at 1100mm below GL. The masonry footing will be in brick work in CM 1:5. The 

first footing being 500X400 and second footing being 400X400 for all walls. 

2. Basement: The basement will be in brick masonry in CM 1:5 Mix 300 wide and 600 thick 

above GL for all walls. In between the walls filled with clear sand of 500mm thick. A damp 

proof course in CM 1:3, 50 thick will be provided for all walls at basement level. 

3. Flooring: The flooring will be in CC 1:4:8, 100mm thick. Plastered smooth with CM 1:3 in 

15mm thick. 

4. Super structure: All walls will be in Brick work in CM 1:5 Mix using first class brick 

300mm thick. The height of wall will be 3300 above Floor level. 

5. Plastering: All the walls including basement will be plastered smooth with 1:4 externally 

and 1:6 internally. Parapet walls 100 thick and 650mm height will be provided all around. 

6. Lintel: All opening will be provided with RCC lintel sunshade 1:2:4 mix, 150 mm thick. 

7. Sunshade: Width of sunshade is 600 mm and 150 thick, free ends 75 tk. 

8. Roofing: The roofing will be of RCC 1:2:4 mix 120 thick flat slabs over the room. A 

weathering course in brick jelly lime concrete 1:5:9 mix plastered with combination mortar 20 

thick over slab. 

9. Steps: Steps will be in brick work in cement mortar 1:5 laid on 150 thick cement concrete 

1:4:8 footing. Rise = 150, Tread = 300. 

10. Doors and windows: 

D- Door paneled - 1200 x 2100 

W- Window paneled - 1200 x 1500 

Refer the figure for the detailed specification of door and window. 

INFERENCE 

The plan of a residential building is drawn from the given line plan. 
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Drawing of Door 
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Drawing of window 
 

Drawing of Load bearing wall 
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PRACTICAL IMPLEMENTATION 

 

1. Knowledge will be helpful to draw components of the building such as walls lintels doors 

and windows object and once we create we can use multiple times 
 

VIVA QUESTIONS 

 

1. What is door? 
 

 
 

2. What are the components of door? 
 

 
 

3. What is the difference between plan and section? 
 

 
 

4. What is section? 
 

 
 

5. what is single storey building? 
 

 
 

6. What is the difference between single storey building and multi storey building? 
 

 
 

7. Define lintel? 
 

 
 

8. Define trim? 
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9. What is an arch? 
 

 
 

10. List the commands used to draw the door and window. 
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EX.NO: 7 
 

Date:  
INTRODUCTION TO 3 – D VIEW 

 

AutoCAD is widely known and utilised as a 2D drafting tool. However, its use for 3D 

modelling is not as prevalent. This post introduces AutoCAD users to some of the most 

common 3D tools in AutoCAD by creating the simple shape. Before we start modelling, we 

need to change the workspace to “3D modeling” from the status bar at the bottom of the 

application. The ribbon will update to show 3D tools. 

 

 
You can start by navigating to an isometric view by clicking on a corner of the view cube on 

the top right of model space. If you do not see the view cube, you can make it visible from the 

‘View’ tab of the ribbon. Launch the 3DPOLY command to draw a closed 3D polyline in the 

front view (XZ plane). Starting on the origin and with ortho mode on (F8), start drawing as you 

would in a 2D view, keeping in mind that if you specify coordinates, you will need to provide 

them in all three axes. 

 

 
Select the EXTRUDE command from the ‘Home’ tab of the AutoCAD ribbon, pick the 3D 

polyline from the previous step and then type 90 as the height of extrusion to create a 3D solid. 

You can control the visual style from the top left corner of model space. 
 

https://www.symetri.co.uk/products/autocad
https://www.symetri.co.uk/products/autocad
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Draw a triangle using a closed 3D polyline as shown below and extrude it to the back of the 

shape. You may find the ‘Extension’ object snap useful to find the vertices of the triangle. 
 

At this point, we have two independent solids that intersect. Pick the UNION command and 

then select them both to combine them into a single object. 
 

 

 

To finish the shape, draw a rectangle on the top face and extrude it to the base. Using the 

SUBTRACT tool, select the solid to subtract from first, press <Enter>, and then select the solid 

to subtract. 
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Some of the benefits of 3D modelling are: 

 

 Using 3D models, users can get a more evocative design, and they can even see the virtual 

images of their projects. 

 An architectural 3D model is much more interesting and realistic than a 2D model. 

 The experience that a 3D model gives is much more compelling and satisfying to the user 

than viewing a 2D drawing. The user can see the impact of all the minor and major 

changes made in a 3D model. This also aids in the better finishing of the designs without 

wasting time and money. 

 3D models are an amazing advantage to interior designers as they get to create and then 

modify 3D interior as well as exterior as per their need and choice. 

 In a 3D design, the user gets to know the physical dimensions of the objects and their 

distance in relation to other objects in the total layout. This feature helps enormously to see 

and modify arrangements of objects based on their sizes. 

 Some artists use a mixture of 3D modelling for best results by editing the 2D computer- 

rendered images from the 3D model. 

 
TOP AUTOCAD 3D COMMANDS 

11. REVOLVE 

 Location: Draw > Modeling > Revolve 

 This AutoCAD 3D command creates a 3D solid by revolving a 2D object around an axis. 

 

12. EXTRUDE 

 Location: Draw > Modeling > Extrude 

 This AutoCAD 3D Extrude command allows the user to create a 3D object by extruding a 

2D face along a line or path. For example, A cylinder can be created by selecting a 2D 

circle and extruding it along with a path. 

 
13. SWEEP 

 Location: Draw > Modeling > Sweep 

 This command helps the user to extrude the 2D objects without the 2D face being 

orthogonal to the beginning of the path. 



COMPUTER AIDED CIVIL ENGINEERING DRAWING LAB 

47 

 

 

14. UNION 

 Location: Modify > Solids Editing > Union 

 This AutoCAD 3D command allows the user to combine two objects converting them into 

one single object. 

 
15. SUBTRACT 

 Location: Modify > Solids Editing > Subtract 

 This command is opposite to the union command; this command works when there is a 

common area in both the objects. Then this command subtracts the object A from the 

object B. 

 
16. INTERSECT 

 Location: Modify > Solid Editing > Intersect 

 With this AutoCAD 3D command, the user is left with the area that is common to both the 

objects. 

 

 
PRACTICAL IMPLEMENTATION 

 
1. Will be able to draw and see element in three dimensions, so that visualization of the 

drawing will be good we can use these 3D drawings to explain and convince the client. 

2. Architectural usages 
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VIVA QUESTIONS 

 

1. Define elevation? 
 

 

 
 

2. What is the minimum clear height of the floor? 
 

 

3. The middle horizontal member of shutter is called . 
 

 

4. Mullion is member employed to sub divide a window or door opening 

vertically. 
 

 

5. A casement window hung horizontally is called _. 

 

 

6. List out the types of windows. 
 

 

 
 

7. A casement window hung horizontally is called . 
 

 

8. What is window? 
 

 

9. What are the components of window? 
 

 

10. What is the difference between plan and elevation? 
 



COMPUTER AIDED CIVIL ENGINEERING DRAWING LAB 

49 

 

 

EX.NO: 8 
 

Date: 

 
AIM 

 
EXERCISE ON 3 – D 

To draw the plan of a residential building for the given line plan 

 
 

SPECIFICATIONS 

The following specifications refer to residential building with RCC flat roof 

1. Basement: The basement will be in RR masonry in CM 1:5 Mix 200 wide and 300 thick 

above GL for all walls. In between the walls filled with clear sand of 150mm thick. A damp 

proof course in CM 1:3, 20 thick will be provided for all walls at basement level. 

2. Flooring: The flooring will be in CC 1:4:8, 130mm thick. Plastered smooth with CM 1:3 in 

20mm thick. 

3. Super structure: All walls will be in Brick work in CM 1:5 Mix using first class brick 

200mm thick. The height of each floor will be 3000 above Floor level. 

4. Plastering: All the walls including basement will be plastered smooth with 1:4 externally 

and 1:6 internally. Parapet walls 200 thick and 450mm height will be provided all around. 

5. Lintel: All opening will be provided with RCC lintel sunshade 1:2:4 mix, 150 mm thick. 

6. Sunshade: Width of sunshade is 600 mm and 150 thick, free ends 75 tk. 

7. Roofing: Trussed roof shown in figure. 

8. Steps: Steps will be in brick work in cement mortar 1:5 laid on 1800x450x150 thick cement 

concrete 1:4:8 footing Rise = 150, Tread = 300. 

9. Doors and windows: 

D- Door -   1200 x 2100 

W- Window paneled -   1200 x 1500 

INFERENCE 

The plan and 3D elevation of the residential building is drawn. 
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PRACTICAL IMPLEMENTATION 

 
1. Will be able to draw and see element in three dimensions, so that visualization 

of the drawing will be good we can use these 3D drawings to explain and 

convince the client. 

2. Architectural usages 
 
 

VIVA QUESTIONS 

 

1. What are dimension variables? 
 

 

 
 

2. What is damp proof course? 
 

 

 
 

3. What is a dwelling? 
 

 

 
 

4. What is stone masonry? 

  _ 
 

 
 

5. What are the different types of foundation? 
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6. What are the different types of truss? 
 

 

 
 

7. Draw north light truss? 
 

 

 
 

8. What is girder? 
 

 

 
 

9. What is purlin? 
 

 

 
 

10. What is damp proof course? 
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CONTENT BEYOND THE SYLLABUS 



COMPUTER AIDED CIVIL ENGINEERING DRAWING LAB 

55 

 

 

 

 

 

 

AIM 

DRAWING THE PLAN, SECTION AND ELEVATION FOR AN 

INDUSTRIAL BUILDING 

To draw the plan of a residential building for the given line plan 

 
 

SPECIFICATIONS 

The following specifications refer to residential building with RCC flat roof 

1. Foundation: The foundation for all walls will be in CC 1:4:8 Mix 600mm wide and 200mm 

thick laid at 600mm below GL. The masonry footing will be in brick work in CM 1:5. The 

first footing being 400X400 for all walls. 

2. Basement: The basement will be in RR masonry in CM 1:5 Mix 200 wide and 300 thick 

above GL for all walls. In between the walls filled with clear sand of 150mm thick. A 

damp proof course in CM 1:3, 20 thick will be provided for all walls at basement level. 

3. Flooring: The flooring will be in CC 1:4:8, 130mm thick. Plastered smooth with CM 1:3 in 

20mm thick. 

4. Super structure: All walls will be in Brick work in CM 1:5 Mix using first class brick 

200mm thick. The height of wall will be 3000 above Floor level. 

5. Plastering: All the walls including basement will be plastered smooth with 1:4 externally 

and 1:6 internally. Parapet walls 200 thick and 450mm height will be provided all around. 

6. Lintel: All opening will be provided with RCC lintel sunshade 1:2:4 mix, 150 mm thick. 

7. Sunshade: Width of sunshade is 600 mm and 150 thick, free ends 75 tk. 

8. Roofing: Trussed roof shown in figure. 

9. Steps: Steps will be in brick work in cement mortar 1:5 laid on 1800x450x150 thick 

cement concrete 1:4:8 footing. Rise = 150, Tread = 300. 

10. Doors and windows: 

D- Door - 1500 x 2100 

W- Window paneled - 1200 x 1200 

 
 

INFERENCE 

The plan of a residential building is drawn from the given line plan. 
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PRACTICAL IMPLEMENTATION 

 

1. Helps in design and detailing of industry building 
 

 
VIVA QUESTIONS 

 

1. State the components of a simple, single storeyed RCC building. 
 

 
 

 

 
 

2. Define foundation for a simple building. 
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3. List the functions of foundation 
 

 
 

 
 

 

4. What is the minimum depth of shallow foundation? 
 

 
 

 
 

5. List out the types of building symbols. 
 

 
 

 
 

6. What are all the basic kinds of building? 
 

 
 

 
 

7. What kinds of doors are available in buildings? 
 

 
 

 
 

8. What is footing? 
 

 
 

9. Define PCC and RCC. 
 

 
 

10. How to fix scale for a building. 
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